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Introduction

Introduction

This document defines the standard and mandatory page layout to be used for printed
documents (PDF[1]) within Kongsberg Maritime AS. Where and how to use this template
is defined by the current quality control regulations. The template is however typically
used for:
• End user manuals for installation, operation and maintenance
• Other documents aimed at end users
• Technical documents for project deliveries

Topics
• Why use a common layout on page 7
• Template on page 8
• Questions and comments on page 8
• Where to find the template on page 8

Why use a common layout
Any document we produce will tell the reader something about us. While the document
carries its own context, the text and the layout of the document says something about the
values that lay behind it. If the language is poor, the layout is a mess or the document’s
structure makes it difficult to read and seek specific information, we are clearly not
regarded as “world class”.

The layout defined for the End user documentation may not be revolutionary. It is simple
and straightforward, but certain details have been added to increase readability. Using
this template, documents from various parts of our organisation will have identical
appearance, and we will easier be regarded as one company.

1. Portable Document Format (PDF) is a file format created by Adobe Systems in 1993 for document
exchange. PDF is used for representing two-dimensional documents in a manner independent of
the application software, hardware, and operating system. Each PDF file encapsulates a complete
description of a fixed-layout 2D document (and, with Acrobat 3D, embedded 3D documents using
U3D) that includes the text, fonts, images, and 2D vector graphics which compose the documents.
(wikipedia.org)
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The structure of the information in each document remains the responsibility of the
author, but several guidelines exist within the documentation community.

Template
A template file to hold the styles necessary to set up a document according to this End
user documentation layout specification is provided for certain editing tools. The styles
used in this template have identical names as those used in the other templates used by
Kongsberg Maritime. This means that text written using any of these templates are easily
converted to any other layout. Whenever possible, buttons and a special menu have also
been added to make the template easier to use.

The End user documentation described in this document is available as a template for
Microsoft Word, and as a stylesheet for the Arbortext XML Editor.

Automatic distribution of the Word template is provided to certain offices. Templates for
other tools are handled and distributed by the documentation community. See Where
to find the template on page 8.

Questions and comments
Questions and comments about the layout specified for End user documentation shall be
posted to the following e-mail address:

km.communication@kongsberg.com

Where to find the template
The Microsoft Word template is found on folder c:\template on each individual
computer. It is the IS/IT Department’s responsibility that each folder on every computer
always contains the correct and updated templates. A structure below the c:\template
folder may be created to hold individual folders targeted specific products and purposes.

The Word template and this description can be downloaded from the branding guidelines
on:

http://www.km.kongsberg.com/branding

8 164830/C

mailto:km.communication@kongsberg.com
http://www.km.kongsberg.com/branding


Structure

Structure

This specification is valid for all types of documents, manuals or books aimed at end user
personnel that shall install, maintain or use the product described. Typical user manual
types are listed in the branding guidelines on:

http://www.km.kongsberg.com/branding

The typical end user manual is provided in A4 or US Letter size. It has a coloured
front page, and it is bound in a white ring leaf book, with spiral binding, or with steel
covers with white back and clear covers.

Topics
• Document classes on page 9
• Document structure on page 9

Document classes
The following document classes are defined.
• Basic document: A basic document is provided with a front page and front matters

as defined in this layout specification. It is normally small, and used when several
individual documents are provided for a compound manual.

• Cover and contents: The cover and contents document is provided for compound
manuals using any number of basic documents in a collection. The cover and contents
document provides an common registration number and document history for the
complete manual, and lists the individual basic documents it comprises.

• End user manual: An end user manual comprises the complete user manual as one
single file with any number of chapters and appendices. The end user manual is
fitted with a colour front page. The PDF file may also – when applicable – include a
dedicated page for the edge of the binder.

Document structure
The structure of the front matters and information in the various manuals are specified
here.

164830/C 9

http://www.km.kongsberg.com/branding


Kongsberg End user documentation

Basic document
1 Front matters

a Title page
Example: Title page on page 80

b Revision and disclaimer page
Example: Revision and disclaimer page on page 81

c Table of contents
Example: Table of contents on page 82

d List of figures (optional)
e List of tables (optional)

2 Chapters
3 Appendices (optional)
4 Index (optional, but highly recommended)

Description: Index on page 23
Example: Index on page 83

5 End page
Description: End page on page 23
Example: End page on page 84

Cover and contents
1 Front page (in colour)
2 Blank page (rear side of front page)
3 Title page (as defined in this specification)
4 Revision and disclaimers page (maximum one page!)
5 List of sections
6 List of figures (optional)
7 List of tables (optional)
8 List of abbreviations (optional)
9 Terminology (optional)
10 Product liability and safety warning (optional)
11 Blank page (optional to establish an even page)
12 Basic documents

End user manual
1 Front page (in colour)
2 Blank page (rear side of front page)
3 Front matters
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a Title page
Example: Title page on page 80

b Revision and disclaimer page
Example: Revision and disclaimer page on page 81

c Table of contents
Example: Table of contents on page 82

d List of figures (optional)
e List of tables (optional)

4 Chapters
5 Appendices (optional)
6 Index (optional, but highly recommended)

Description: Index on page 23
Example: Index on page 83

7 End page
Description: End page on page 23
Example: End page on page 84
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Interactive assistance for
MS Word users

The author of any document is provided with interactive guidance when the document
is created.

Note

These features are currently only applicable for Microsoft Word.

Topics

• Document properties and metadata on page 12
• Tool box on page 13
• Menu on page 13

Document properties and metadata
When using Microsoft Word, the document properties (registration number, product
name and other metadata) are entered using a dedicated dialog box that automatically
opens when the document is started. The dialog can also be opened manually by clicking
the Add data button in the tool box.

When a Microsoft Word document is created within specific environments, the metadata
is automatically extracted and inserted into the document.

The relevant metadata to be recorded is defined in chapter Metadata for MS Word on
page 78.
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Tool box
A tool box is provided to access the most common styles. The box contains these styles
grouped as follows:

• Add data

• Normal text

• Headings

• Lists

• Remarks

Menu
A dedicated menu “Kongsberg” is added to theMicrosoft Word menu. This menu allows
access to all the styles.

164830/C 13
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Basic elements for
typography and layout

This chapter describes the basic rules related to typography and page layout.

Topics
• Logo on document title page on page 14
• Fonts and typefaces on page 14
• Page set-up on page 15
• Page and text margins on page 15
• Page numbering on page 16
• Section numbering on page 16
• Printing on page 17

Logo on document title page
The KONGSBERG logo is always placed in the top right corner of the document’s title
page. The following specifications apply:
• Physical size of logo

– Paper and PDF output: Width 25 mm (the height is automatically adjusted)
– HTML and CHM output: Width 150 pixels

• Location of logo:
– Vertical: Inside top margin (25 mm from the top of the paper)
– Right: Inside right margin (30 mm from the right side of the paper edge)

Fonts and typefaces
The standard fonts to be used in all Kongsberg Maritime documents are defined in the
branding guidelines on:
http://www.km.kongsberg.com/branding

14 164830/C
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Currently, all body text is presented in Times New Roman. The standard font size for A4
and US Letter page format is 12 pt. Headings are presented in Verdana using various font
sizes. The layout of these components are described in the Styles chapter.
In tables, you are permitted to use Times New Roman with a smaller font.
For more information, see Styles on page 49.

Page set-up
With the exception of specific landscape drawings, all information must be presented
in portrait page format using a single column between the page margins. The layout
is defined by the styles.
Whenever possible, illustrations drawn in landscape format must be reduced in size or
redrawn to fit on a portrait page. Descriptive text can then be located on the same page
as the illustration. Lists of spare parts, where order numbers, supplier details, quantity
details and other information is required, may be presented in landscape format if
required to keep the information on one line or to keep the layout neat.

Note

The use of landscape pages – which forces the user to turn the book around – shall
only be used exceptionally.

Page and text margins
Page margins are used to position the text on the page and to provide a border to the text.

Note

No body text or illustrations are to be printed on any page outside the page margins.

The page headers and footers are located within the top and bottom margins respectively.
For A4 and US Letter, the margins are to be as follows (as defined in Microsoft Word):
• Left: 3 cm from left edge of page to left page margin
• Right: 3 cm from right edge of page to right page margin
• Top: 4,3 cm from top of page to top of body text
• Bottom: 3 cm from bottom of body text to bottom of page
The different text editors use different properties to set up the page size and margins. In
Microsoft Word, these are set up as follows:
1 Select File on the main menu, and then Page Setup.
2 Click the Margins tab, and check the following settings:

• Top: 4.3 cm
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• Bottom: 3 cm
• Left: 3 cm
• Gutter: 0 cm
• Gutter position: Left

3 Click the Layout tab, and check the following settings:
• Headers and footers: Different odd and even
• From edge: Header: 2.5 cm
• From edge: Footer: 1.7 cm
• Vertical alignment: Top

4 Make sure that these settings apply to all pages.

Mirror margins are not enabled.

The text margin (horizontal space provided for the text) is identical to the page margin.

Page numbering
Under normal circumstances every page of a document is to be numbered, though the
style of numbering will vary depending on the type of document and where in the
document the page is located. The following rules apply:
• In all documents, the page numbers will start with the Title page as page 1. Arabic

numbers are mandatory.
• If a colour Front page is used, it shall not be numbered.
• Compound numbering, for example chapter number and page number in that chapter

(1.1, 1.2 etc.) shall not be used.

The location of the page numbers is defined in chapter Headers and footers on page 24.

Section numbering
Section numbering is used according to guidelines provided by the documentation
community.

Section numbering must however be used if specified in a delivery contract, or in a
layout or document standard specified within a delivery contract.
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Printing
The layout of the headers and footers are set up for double sided print.

All pages are to be printed on both sides to save paper, and to reduce the physical size
of documents and user manuals. Exceptions are only allowed when a delivery contract
specifically demands single-sided printing.

164830/C 17
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Front and rear matters

The Title page of the document reflects the document name. It contains the document
title, a subtitle and a brief introduction (ingress). Release date and current version is
provided at the bottom of the page.

The front matters in a document include the following elements:
a Title page

Example: Title page on page 80
b Revision and disclaimer page

Example: Revision and disclaimer page on page 81
c Table of contents

Example: Table of contents on page 82
d List of figures (optional)
e List of tables (optional)
Note

Dedicated pages in the front matters related to Cardio Pulmonary Resuscitation (CPR)
and life saving procedures are not permitted.

Topics
• Title page on page 18
• Revision and disclaimer page on page 19
• Additional information in the front matters on page 21
• Table of contents on page 22
• Index on page 23
• End page on page 23

Title page
The title page holds the KONGSBERG logo as described in the Basic elements chapter.
See Logo on document title page on page 14.
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The title page further contains the following information. All text placement and
distances are defined in the styles.
• Document title using style FrontTitle
• Document subtitle using style FrontSubTitle
• Product part number (when applicable) using style PartNumber
• Product release information (when applicable) using style ReleaseInfo
• Document introduction using style Ingress.
• Copy number (only when applicable) (Located in the footer, see Footers on page 25.)
• Document release date and copyright (Located in the footer, see Footers on page 25.)
• Document revision (Located in the footer, see Footers on page 25.)

Example
• Title page on page 80

Related topics
• Basic elements for typography and layout on page 14
• Styles for the Title page on page 62

Revision and disclaimer page
This is page number 2 on the rear side of the title page. The page contains (from the top):
1 Heading “Revision status” using style GenericTitle.

See GenericTitle on page 69.
2 Table with revision status.

See Using the Revision status table on page 20 and Revision status table
specification on page 20.

3 Disclaimers:
• Slimhinner heading using style GenericTitle.

See GenericTitle on page 69.
• Slimhinner text using style Slimhinner.

See Disclaimer on page 55.
Which disclaimers to use is described in section Disclaimers on page 21.

Note

The Revision and disclaimer page is physically restrained to one single page. If the
Document status table contains a large number of revisions, you may need to delete
the top rows.

164830/C 19
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Example
• Revision and disclaimer page on page 81

Using the Revision status table
The Revision status table may have one of two functions:
• It contains a chronological list of document revisions. If the number of revisions

causes the table to exceed the space available on the revision and disclaimer page, the
table row(s) containing the oldest revisions are deleted.

• It contains only the current revision of the document.
The top row of the Revision status table (Row “Document number”) shall contain the
document’s registration number, ISBN number (if applicable), and current revision.

Each of the remaining rows in the Revision status table (Row “Revisions”) shall contain
revision identification, date, and a short description of the document version/release. If
the product’s software version is important for the information provided by the document,
this shall be included. If it is necessary to include a large and very detailed list of all the
changes done to the document, a dedicated bullet list must be implemented at the end of
the first chapter in the book. The information in the table must then refer to this list.

Example:
Document no: 164830 / ISBN-13: 978-82-8066-116-6 / Revision: C

Rev.A 11 April 2008 First version.

Revision status table specification
The Revision status table is defined with the following common specifications:
• All line widths: Standard Microsoft Word “single line” or 1 pt
• Total width of table: 150 mm
• Height of each row: Height to fit content
If the Revision status table contains a high number of releases, the vertical size of the
table may reduce the space allocated for the standard copyright text. If this is a problem,
remove the first few releases in the table to create sufficient space.

The table rows are defined as follows. All fonts are Times New Roman 10 pt.

1 Row “Document number”:
• Cell 1 Document no.: Width 150 mm, text bold, aligned left, 10% shaded (XML:

“Gray1”)
In XML DocBook, use a regular header row in <informaltable> within
<legalnotice>.

2 Row “Revisions”:
• Cell 1 [Blank]: Width 15 mm, text normal, aligned left
• Cell 2 [Blank]: Width 30 mm, text normal, aligned left
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• Cell 3 [Blank]: Width to fit remaining space, text normal, aligned left
In XML DocBook, use a regular row in <informaltable> within
<legalnotice>.

Note

The Revision and disclaimer page is physically restrained to one single page. If the
Document status table contains a large number of revisions, you may need to delete
the top rows.

Disclaimers
The following disclaimers are used in the front matters.
The text to be used in the disclaimers is provided on
http://www.km.kongsberg.com/branding .
1 User

This information is provided to define the target reader, and specify the education,
experience or training expected. If the reader is defined elsewhere in the manual (for
example in the introductory chapter), this disclaimer entry may be omitted.

2 Copyright
3 Warning

This disclaimer instructs the reader to only use the product for the purposes it is
intended for.

4 Support information
This disclaimer provides brief information about support, including references to
dealers, an e-mail address and the website URL.

5 Additional information (optional)
Additional information may be added to the disclaimer if this is necessary for specific
deliveries or special products. Refer to http://www.km.kongsberg.com/branding
for more information.

Use style GenericTitle for all headings, and Slimhinner for all disclaimer text. See
GenericTitle on page 69 and Disclaimer on page 55.

Note

The Revision and disclaimer page is physically restrained to one single page. If the
Document status table contains a large number of revisions, you may need to delete
the top rows.

Additional information in the front matters
Additional information may be added to the front matters as required. This may typically
be a list of illustrations, a list of abbreviations etc.

164830/C 21
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List of illustrations

When a list of illustrations is required, it is placed immediately after the table of contents.
Use a format suited for the information to be provided. For the title above the list, use
style Head:Centre. See Head:Centre on page 68.

List of tables

When a list of tables is required, it is placed immediately after the table of contents, but
after a list of illustrations if such a list exists. Use a format suited for the information to be
provided. For the title above the list, use style Head:Centre. See Head:Centre on page 68.

Glossary

A “glossary” is list that may contain definitions, acronyms and/or abbreviations. Only
the phrase “Glossary” is permitted as title for such a list. When a glossary is required, it
is placed immediately after the table of contents, but after a list of illustrations and/or list
of tables if any of these lists exist. Use a format suited for the information to be provided.
For the title above the list, use style Head:Centre. See Head:Centre on page 68.

Note

A dedicated glossary is optional. If your document contains phrases or names that needs
to be explained, try to do so in a footnote, or within the body text.

List of abbreviations

A “glossary” is list that may contain definitions, acronyms and/or abbreviations. Only
the phrase “Glossary” is permitted as title for such a list. When a glossary is required, it
is placed immediately after the table of contents, but after a list of illustrations and/or list
of tables if any of these lists exist. Use a format suited for the information to be provided.
For the title above the list, use style Head:Centre. See Head:Centre on page 68.

Note

A dedicated list of abbreviations is optional, and should be avoided. If your document
contains a phrase or name that is abbreviated, explain it within the body text the first
time it is used in each topic.

Table of contents
The table of contents is generated automatically, and it is always placed at the top of the
first page after the revision and disclaimer information.

The title Table of contents is written using style Head:Centre, see Head:Centre on
page 68.
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The individual lines in the table of contents are written using the dedicated styles for
these, see Styles for the Table of contents on page 72.

Example

• Table of contents on page 22

Index
The index is located at the end of the basic document or end user manual, and positioned
after the last chapter or appendix.

The index is set up using three columns, and Times New Roman font. The title “Index”
is set up using the Head:Centre style.

Note

Implementing an index is optional, but highly recommend.

Related topics

• Style Head:Centre on page 68
• Example Index on page 83

End page
The end page is the very last page in the book. The end page shall always be on an
even page number.

The only information to be placed on the end page is:
• ISBN number (if applicable)
• Publishing year, copyright symbol and the name “Kongsberg Maritime AS”.

The information is place at the top of the page, centred, using standard normal text.

Related topics

• Example End page on page 84
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Headers and footers

Each page of a document shall have a page header located across the top of the page, and
a page footer located across the bottom. The headers and footers contain information
about the document, enabling identification of the individual pages.

The headers and footers defined here are intended for double-sided printing.

Topics

• Headers on page 24
• Footers on page 25

Headers

Header on Title page
The Title page does not contain a header.

Header on Revision and disclaimer page
The Revision and disclaimer page does not contain a header.

Header on odd pages
All odd pages in the document shall contain a header defined as follows:
1 Font: 12 pt. Times New Roman
2 Location: Contained within left and right page margins, flushed to the right page

margin. The distance to the top of the sheet is defined by the page setup properties.
3 Content: Document type or chapter name (depending on the page’s location in

the document structure)
In XML documents, the stylesheet causes the document type or chapter name to be
inserted automatically.
In an XML document defined with <book role=”shortdoc”>, only the
document type is shown.
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4 Line: A horizontal separation line (base line) runs from the left page margin to the
right page margin. The line weight must be 0.3 mm. There must be 2 mm between
the text in the header and the base line (approximately 2.2 cm from top of page
to base line).

In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.

Header on even pages
All even pages in the document shall contain a header defined as follows:
1 Font: 12 pt. Times New Roman
2 Location: Contained within left and right page margins, flushed to the left page

margin. The distance to the top of the sheet is defined by the page setup properties.
3 Content: Product name and/or Client/Vessel name as appropriate.
4 Line: A horizontal separation line (base line) runs from the left page margin to the

right page margin. The line weight must be 0.3 mm. There must be 2 mm between
the text in the header and the base line (approximately 2.2 cm from top of page
to base line).

In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.

Footers

Footer on Title page
The footer for the Title page is designed as follows:
1 Font:

• Line 1: 11 pt. Verdana
• Line 2: 8 pt. Verdana

2 Location: Adjusted to the right text margin. The distance to the bottom of the sheet
is defined by the page setup properties.

3 Content:
• Line 1:

– Flush left: Text Copy no:_____ (Optional).
– Flush right: Document registration number and revision written as follows:

123456/A.
• Line 2:

– Flush left: Text Unregistered copies will not be updated.
– Flush right: Publishing date and/or month plus copyright.

Example: May 2009 © Kongsberg Maritime AS.
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In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.

Footer on Revision and disclaimer page
The footer for the Revision and disclaimer page is designed as follows:
1 Font: 11 pt. Times New Roman normal
2 Location: Centred. The distance to the bottom of the sheet is defined by the page

setup properties.
3 Content: Website URL

• Line 1: Company name
• Line 2: Website URL

In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.

Footer on odd pages
The footers for the odd pages are designed as follows:
1 Font:

• Document identification and revision: 9 pt. Times New Roman
• Page number: 12 pt. Times New Roman

2 Location: From the left to the right margin. The distance to bottom of page is
defined by the page setup properties.

3 Content:
• Justified left to the left margin: Document identification and revision character

written as follows: 123456/A
• Justified right to the right margin: Page number

In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.

Footer on even pages
The footers for the even pages are designed as follows:
1 Fonts: As for odd pages.
2 Location: As for odd pages.
3 Content:

• Justified left to the left margin: Page number.
• Justified right to the right margin: Document identification and revision character

written as follows: 123456/A.
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In XML documents, the contents of all footers and headers are defined in entities. This
will allows all footers and headers to be set up automatically.
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General rules for text and
illustrations

This chapter specifies the general rules related to writing text and creating illustrations.

Topics

• Creating text on page 28
• Increase the readability of your text on page 34
• Identifying functions, names and references on page 35
• Drawings, photos and illustrations on page 37

See also

• Procedures on page 43
• Tables on page 46

Creating text
It is very important that our documents contain correct and precise text. The fact that the
majority of our documents are written in English also places emphasis on your language
skills. Common for all languages and documents are several basic rules for writing.

Language
The language is defined at corporate level. We use British (UK) English. American
spelling is only to be used if the context relates to Microsoft Windows and those
standards apply, or for other special reasons. Documents originating in the US are
excepted from this rule.

Document titles and captions
A document title is the word or phrase used at the beginning of each chapter or section.
A caption is the words or phrases used to identify an illustration or a table.
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We only use capital letters in the beginning of sentences, for names, or whenever
required for special purposes.
• We do not use capital letters on every word in titles, captions etc.
• We do not use periods after titles.
• We do not use periods in titles.

Examples
• How to power up the Operator Station
• System description

Front page titles
A front page title is the word or phrase used at the top of the front and title pages.
In front page titles, we only use capital letters in the beginning of the title, for names, or
whenever required for special purposes. We do not use all caps.

Examples
• SDP Operator manual
• EM 3000 Functional design specification

Itemized lists (bullet lists)
The use of itemized lists is encouraged to increase readability. The itemized lists may be
nested to maximum two levels.

Example
• Level 1
• Level 1

– Level 2
– Level 2

In XML DocBook, you are permitted to give the itemized list a title.

Ordered lists
The use of ordered lists is encouraged to increase readability, and is mandatory for
procedures. The ordered lists may be nested to maximum two levels. Itemized lists are
permitted within the ordered lists.

Example
1 Level 1
2 Level 1

a Level 2
b Level 2
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In XML DocBook, you are permitted to give the ordered list a title.

Procedures
Procedure lists are only available in XML DocBook. They have the same appearance as
ordered lists.
When you write a procedure, make sure that the action is short, brief and to the point
using imperative mood. Information not related to the actual action must not be placed in
the same sentence. Use a separate paragraph below the action sentence, or a bullet list.
Additional information about procedural writing is offered in the guidelines provided by
the documentation community.

Example
1 Press the On button.

The red lamp is lit.
In XML DocBook, you are permitted to give the procedure a title.
For more information, see Procedures on page 43.

Justification
All text is justified to the left. In tables, text may be justified centre or right only if this
enhances the readability of the information.

Note

Right justification is not permitted.

References
It is often necessary to refer the reader to other sections or chapters in the manual, to an
illustration, or even to a separate document or manual.
Use a full stop after the reference only if the text forms a full sentence.
Avoid phrases like “as shown below” or “in the illustration above”. If illustrations are
moved or replaced, either automatically or by purpose, such phrases may only confuse
the reader. If you must refer to an illustration, use a caption and refer to the caption
and page numbers.
To create a page reference to a chapter, section, table or illustration within the same
document, we shall always refer to titles together with page numbers, and never to figure
numbers or paragraph numbers by themselves.
To present page or section references, the following methods are available.
1 Inline reference
2 Bullet list with title “Topics”
3 Bullet list with title “Related topics”

30 164830/C



General rules for text and illustrations

4 Bullet list without title, but with special bullets
The title of the referenced section or chapter is always written using italic characters.

Inline references

1 For page references within the same document, use the XML <xref> tag.
Example: For more information about this feature, refer to Operational modes on
page 25.
In Microsoft Word, use italics.

2 To reference a section or chapter within the same document, but without
providing the page number, place the title you refer to inside the XML <phrase
role=”sectitle”> inline tag.
In Microsoft Word, use italics.
Example: For more information about this feature, refer to the Operational modes
chapter.

3 To reference another document or manual, place the title you refer to inside the
XML <phrase role=”doctitle”> inline tag.
In Microsoft Word, use italics.
Example: For more information about this feature, refer to the EM 3002 Installation
manual.

Bullet list with title “Topics”

This method is typically used at the beginning of a chapter and/or section to create
a table of contents.
Use a standard bullet list (XML Docbook <itemizedlist>), and use title “Topics”. The
title must be provided with style GenericTitle. See GenericTitle on page 69 for details.
Example: See the various chapters in this document for examples.
Note that each reference does not have a full stop, as these are not full sentences.
Do not place inline references in bullet lists.

Bullet list with title “Related topics”

This method is typically used at the end of a section or a chapter to create a summarized
list of references.
Use a standard bullet list (XML Docbook <itemizedlist>), and use title “Related
topics”. The title must be provided with style GenericTitle. See GenericTitle on page 69
for details.
Example:

Related topics
• Operational modes on page 25
• Getting started on page 44
Note that each reference does not have a full stop, as these are not full sentences.
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Do not place inline references in bullet lists.

Bullet list without title

This method is typically used within the body text when you wish to place one or more
page references as separate elements.
Use a standard bullet list (XML Docbook <itemizedlist>), but do not use a title.
Instead, apply role=”related” to the itemized list.
Example:
→ Operational modes on page 25
→ Getting started on page 44
Note that each reference does not have a full stop, as these are not full sentences.
Do not place inline references in bullet lists.

Tip and Information elements in XML
Special attention to information may be drawn using the XML <tip> and
<information> elements.
These elements are only available in XML.
The layout of these components are described in the Styles chapter.

Notes, cautions and warnings
Important text will often require special attention from the reader. In such cases, Notes,
Cautions or Warnings are used.
• A Note is used to draw the reader’s attention to a comment or some important

information.
Definition made by the documentation community:
A Note is used to draw the reader’s attention to a comment or some important
information.

• A Caution is used to warn the reader that a risk of damage to the equipment exists
if care is not exercised.
Definition made by the documentation community:
A Caution is used to warn the reader that a risk of damage to the equipment exists
if care is not exercised.

• AWarning must only be used when it is necessary to warn personnel that a risk of
injury or death exists if care is not exercised.
Definition made by the documentation community:
AWarning should only be used when it is necessary to warn personnel that a risk of
injury or death exists if care is not exercised.

The layout of these components are described in the Styles chapter. A horizontal line
may be used before and after notes, cautions and warnings.

32 164830/C



General rules for text and illustrations

XML DocBook example

Note

This is a note. It is used to draw the reader’s attention to a comment or some important
information.

For more information, see:

Topics
• Remark:Note on page 70
• Remark:Caution on page 70
• Remark:Warning on page 71

Controlling page breaks
In long documents, it is important that the location of page breaks are controlled to
avoid unfortunate breaks. Do not use the forced page break function supported by some
text editors, but define headings and components in such a way that they automatically
adjust to page breaks. Even so, before a document is printed, check that page breaks
do not occur:
• After a heading (can be controlled by the heading definition)
• After a paragraph ending with a colon (:)
• Before the last item in an itemized or numbered list.
• Between a numbered item in a procedure and the comment following it.

It is also important that you check the location of illustrations.

Tip

MS Word: How to attach one paragraph to the next

If you want to paragraphs to be printed together in Microsoft Word:
1 Place the cursor in the upper paragraph.
2 Press the right mouse button, and click Paragraph on the short-cut menu.
3 Click the Line and page breaks tab in the Paragraph dialog.
4 Click Keep with next.

Arbortext XML: How to attach several elements together

If you want to paragraphs (or any other elements) to be printed together in Arbortext
XML:
1 Select the elements that you wish to be printed together on one page.
2 Click Format →Touchup →No page break region.
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Common mistakes
Please observe the following common mistakes, and do your best to avoid them:
• Do not use the Space bar to create indents.
• Do not use the Enter key to create vertical space. The vertical space between each

paragraph is defined in the styles.
• Do not use Ctrl-Enter to create a page break.
Tip

MS Word: How to create a page break

If you want to create a page break in Microsoft Word:
1 Place the cursor in the paragraph to be placed on the top of a new page.
2 Press the right mouse button, and click Paragraph on the short-cut menu.
3 Click the Line and page breaks tab in the Paragraph dialog.
4 Click Page break before.

Arbortext XML: How to make a section start on a new page
1 Place the cursor behind the <section> tag.
2 Press Ctrl+D to modify the attributes.
3 Enter role=newpage.

Increase the readability of your text
Writing for a technical audience is no excuse for unclear and complex sentences. You
can use simple sentence structures and straightforward language for the most complex
topics. The length and complexity of your sentences affects the readability of your text.
The longer your sentences are, the more ideas the reader must absorb.

Observe the following general guidelines to reduce the complexity of your sentences:
• Use the present tense of verbs.
• Use the active voice of verbs whenever possible. Use the passive voice when the

subject is unknown, unimportant or assumed.
• Use declarative sentences in the pattern subject - verb-complement for statements of

fact. This pattern is particularly important for long sentences so that the relationship
between sentence elements is clear to the reader.

• Use tables and figures to enhance text or instead of text.
• Be aware of the average length of your sentences. You do not have to count each word

in each sentence, but examine your sentences as you write or read. If your sentences
are often over 20 words, you are certainly using too complex a style.
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However, do not confuse simplicity with simplistic writing; do not patronise your
audience. Avoid using a conversational tone in your documents. Do not use words
such as actually, basically, easy, simply and just. Although they may seem to make the
text more reader friendly, these words indicate a subjective judgement and are often
meaningless.
Remember that even though we use languages that are widely understood, usually
English and the Latin alphabet, the reader is often neither native nor fluent in this
language and eloquence may defeat the purpose.

Identifying functions, names and references
In all text, we frequently identify functions, buttons, dialog boxes, menus etc. We also
frequently refer to other sections, chapters or manuals. In all these cases, the names are
written with a special typeface. The various editors used allow for different functionality.
For this reason, the list below provides two alternatives, one for a generic text editor, and
the other for an XML editor using the DocBook DTD.

Dialog box name and tab name
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guilabel> tag.
• Examples:

– Generic: The transceiver parameters can be modified in the Transceiver
Installation dialog.

– XML DocBook: The transceiver parameters can be modified in the Transceiver
Installation dialog.

– XML DocBook: To change these parameters, click the Heading tab.

Menu names
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guimenu> tag.
• Examples:

– Generic: In order to print, open the Operation menu.
– XML DocBook: In order to print, open the Operation menu.

Menu items
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guimenuitem> tag after a <guimenu>

tag. The stylesheet automatically inserts an arrow.
• Examples:

– Generic: To print, click Operation and then Print.
– Generic: To print, click Operation – Print.

164830/C 35



Kongsberg End user documentation

– XML DocBook: To print, click Operation →Print.

Sub-menus
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guisubmenu> tag after a <guimenu>

tag. The stylesheet automatically inserts an arrow.
• Examples:

– Generic: To control the view, click View and thenWindow control.
– Generic: To control the view, click View –Window control.
– XML DocBook: To control the view, click View →Window control.

Dialog box buttons
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guibutton> tag.
• Examples:

– Generic: To start the print process, click the OK button.
– XML DocBook: To start the print process, click the OK button.

Dialog box text and labels
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guilabel> tag.
• Examples:

– Generic: To start the print process, observe the commands in the Print field.
– Generic: In theWallpaper list, click the background wallpaper of your choice.
– XML DocBook: To start the print process, observe the commands in the Print field.
– XML DocBook: In the Wallpaper list, click the background wallpaper of your

choice.

Physical buttons on keyboards and operating panels
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <keycap> tag.
• Examples:

– Generic: To start the print process, press the Enter button.
– XML DocBook example: To start the print process, press the Enter button.

Keyboard combinations
• Generic: These are written using bold characters.
• XML DocBook: These are written using the <keycombo> tag containing two (or

more) <keycap> tags.
• Examples:

– Generic: To save, press the Alt+S buttons.
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– XML DocBook example: To save, press the Alt+S buttons.

Icons (either a graphic or a text)

• Generic: These are written using bold characters.
• XML DocBook: These are written using the <guiicon> tag.
• Examples:

– Generic: To start the print process, observe the Printer icon.
– XML DocBook example: To start the print process, observe the Printer icon.

Operational modes

• Generic: These are written using italic characters.
• XML DocBook: These are written using the <phrase role=”mode”> tag.
• Examples:

– XML DocBook: To open the Wide mode, click Mode →Wide.

Data presentation views

• Generic: These are written using italic characters.
• XML DocBook: These are written using the <phrase role=”view”> tag.
• Examples:

– XML DocBook: The depth is shown in the Echo sounder view.

Reference to section title

• Generic: These are written using italic characters.
• XML DocBook: These are written using the <phrase role=”sectitle”> tag.
• Examples:

– XML DocBook: This function is explained in the Echo sounder section.

Reference to document title

• Generic: These are written using italic characters.
• XML DocBook: These are written using the <phrase role=”doctitle”> tag.
• Examples:

– XML DocBook: This function is explained in the ES60 Operator manual.

Drawings, photos and illustrations
Graphics in combination with text can be a powerful tool to emphasize the point and help
the reader visualize the message.
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There are no fixed rules on how and where to position illustrations. These come in
a variety of shapes and sizes, and the final appearance on the page is often a matter of
personal preferences within the capabilities of the text editor. However, the following
rules and guidelines exist.

Note

Illustrations must never exceed the page margins!

Graphic frames

Using frames on illustrations

We do not frame illustrations when these are inserted into the text flow of a section
or chapter.

Drawing file graphics

When a document contains a “Drawing file” chapter or section, the drawings are
normally large and require a full page size.

These drawings are then placed within a 200 x 150 mm standard frame, and each page in
the section or chapter contains only the section heading and the drawing, no caption and
no additional text.

Frame specifications

• Size: 200 mm high, 150 mm wide
• Line width: 0,25 mm
• Standard text:

– Font: Arial 8 pt
– Text position: 2 mm from bottom, 2 mm from left and right sides
– Left side: All measurements in mm. The drawing is not in scale

using two lines.
– Right side: Illustration identification and revision, and illustration name

• On-line help version: PNG format, width 500 pixels, transparent background

A ready-made frame in CorelDraw format can be imported from the following folder:

\\romeo\00281\format specifications and templates\Graphic frame
for drawing file

Example

• Graphic frame for drawing files on page 85

38 164830/C



General rules for text and illustrations

How to position an illustration
The total width of the page (between the left and right margin) is 15 cm. We recommend
that you always create illustrations with this width in mind. Whenever possible, create
the illustrations in scale 1:1 to fit the page width.

Illustrations may be placed in four different ways. Before placing the illustration,
consider the illustration’s physical size and importance.
1 Alone with the text above and below (no wrap). The illustration must then be

aligned to the left margin, or centred between the page margins.
Use this method if the illustration is large, typically wider than 75 mm, or if you
wish to make the illustration stand out.
XML DocBook:
• Use the <figure> or <informalfigure> elements. In some situations (for

example within a table cell, you can also use the <mediaobject> element.
• By default, all illustrations are aligned to the left margin.

2 Text wrapped around the right side of the illustration.
Use this method if the illustration is small, typically 75 mm wide or less. If the
information provided by the text is more important than the information from the
image, place the text on the right side of the illustration.
In XMLDocBook, use <role="leftwrap"> on <figure> and
<informalfigure>.

3 Text wrapped around the left side of the illustration.
Use this method if the illustration is small, typically 75 mm wide or less. If the
information provided by the image is more important than the information from the
text, place the image on the right side of the text. A typical example is a system
diagram, where the text on the diagram’s left side only identifies the various system
components.
In XMLDocBook, use <role="rightwrap"> on <figure> and
<informalfigure>.

4 “Inline” placing the graphic element as a character within the text in the paragraph.

Note

Use inline graphics with caution. Graphic elements with size exceeding the height
of the characters will derange the layout of the page, and may garble the message.
Inline graphics must thus be very small.

In XML DocBook, use element <inlinemediaobject>.

When a document contains a “Drawing file” chapter or section, the drawings are normally
large and require a full page size. These drawings are then placed within a 200 x 150 mm
frame, and each page in the section or chapter contains only the section heading and the
drawing, no caption and no additional text. See Drawing file graphics on page 38.
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Note

Illustrations must never exceed the page margins!

For more information about text wrapping in XML and Microsoft Word, see Tables used
as a layout method on page 48.

Examples

Figure 1 Illustration aligned to the left margin, no wrap

Figure 2 Illustration and text
placed next to each other

This example shows how text is “wrapped” with the
illustration. In order to create this effect, an invisible
table is used. The left cell has a defined width. In this
example, this text is vertically adjusted to the middle
of the cell.

Figure 3 Illustration and text placed next to each other, text at bottom

In this example, (made with XML), the table with the
illustration and this text is placed within the <figure>
element. To place the illustration in the table cell, only
the <mediaobject> element is used. This text is
vertically adjusted to the bottom of the cell.
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Figure 4 Illustration and text placed next to each other, text at top

In this example, (made with XML), the table with the
illustration and this text is placed within the <figure>
element. To place the illustration in the table cell, only
the <mediaobject> element is used. This text is
vertically adjusted to the bottom of the cell.

Importing graphics
The various editors provide different methods to import graphics. We recommend the
following methods:
• If you use Microsoft Word, import the file using Insert →Picture →From file.
• If you use Adobe InDesign, place the image in the same folder as the INDD file (or a

sub-folder), and link the graphics into the document using File →Place. You can also
link graphic files directly from the archive.

• If you use Arbortext XML Editor, link the illustrations into the document using
the <informalfigure> or <figure> tags. If you create documents for multiple
outputs, link to dedicated versions of the graphics and profile for optimal quality.

Working with line drawings
The total width of the page (between the left and right margin) is 15 cm. We recommend
that you always create illustrations with these widths in mind. Whenever possible, create
the illustration in scale 1:1. That allows you to check font sizes, line widths and the
details in the drawing before you insert it into the document.

Which file formats to use will often depend on which editor you use.
• If you use Microsoft Word, we recommend that you convert your illustrations to EPS

or WMF format. Note that documents containing EPS graphics will only print on
postscript printers.

• If you use Adobe InDesign, convert to EPS.
• If you use Arbortext XML Editor, convert line drawings to EPS or TIF for printed

output, and PNG or GIF for CHM/HTML output.

Working with screen captures
A screen capture will always have a very poor resolution; 72 dpi. The physical size of
the screen capture will however depend on the screen resolution, so we recommend that
you always capture screen shots from a very large high resolution monitor.

Do not try to change the size of the bitmap. Since the resolution is so poor, you will
easily ruin the readability.

We recommend that you use the PNG file format in all editors.
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Working with photographs and high resolution bitmap
images

Software

High resolution images can be used for all outputs.

The best software application to handle all types of bitmap images is Adobe PhotoShop.

Images sizes and file formats

We recommend that you use Adobe PhotoShop to adjust the physical size of the image
to 150 mm width (or less) and 300 dpi. Do not underestimate the value of high quality
source files when working in Adobe PhotoShop.

Images for CHM/HTML output must be re-sized accordingly. Adobe PhotoShop offers
a dedicated function to do this.

We recommend that you use the TIF format in all editors.
• If you use Microsoft Word, we recommend that use the TIF format. If you experience

difficulties with the editor due to the file size, try the JPG format.
• If you use Adobe InDesign, convert to TIF with CMYK colours.
• If you use Arbortext XML Editor, convert to TIF with CMYK colours for printed

output, and PNG or JPG for CHM/HTML output.

Equipment

We recommend that you use digital single-lens reflex (DSLR) cameras, whenever
practical.
• Modern compact cameras are easy to handle in field conditions, and having a picture

at all is priority number one.
• DSLR cameras provide a range of options when it comes to challenging light

conditions and interchangeable lenses.
• Studio conditions provide an able photographer with full control of lighting and

options for assessing the results on a large computer screen.
• Photographing in RAW format will preserve the camera sensor data unaltered. This

will support the full 16 bit colour range available in TIF, and preserve a range of
adjustment options that are irrevocably lost in JPG compression.

• Cameras use many different proprietary RAW file formats, so we recommend using
the publicly available Digital Negative (DNG) as well as a storage media backup
for long-term archiving.

For more information, see:
• http://www.adobe.com/products/photoshop/cameraraw.html
• http://www.adobe.com/products/dng/

42 164830/C

http://www.adobe.com/products/photoshop/cameraraw.html
http://www.adobe.com/products/dng/


Procedures

Procedures

This chapter specifies the general rules related to procedures.

Topics

• About procedures on page 43
• Specifications for procedures on page 44
• Example on page 45

About procedures
A procedure is a specified series of actions, acts or operations which have to be
executed in the same manner in order to always obtain the same result under the same
circumstances (for example, emergency procedures). Less precisely speaking, this word
can indicate a sequence of activities, tasks, steps, decisions, calculations and processes,
that when undertaken in the sequence laid down produces the described result, product or
outcome. A procedure usually induces a change.

When you need to write a procedure, observe the following rules.
1 Use imperative mood in a numbered list to describe what you want the reader to do.
2 Do not describe actions and results in the same paragraph. All comments to a

required action, or results from the action, must be described in a separate paragraph
below the imperative numbered command.

3 If the result from a given command is important, you may write it as a new
command, using phrases like “Ensure that..” or “Observe that...”

4 Whenever necessary, you can use “sub-procedures” if an instruction needs to be
split into separate numbered actions. Sub-lists use alphanumerical identification
(a, b, c etc).

Styles to create all the necessary items in a procedure are included with the template.
The layout of these components are described in the Styles definitions chapter.
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Specifications for procedures
In order to establish a common organisation of all procedures, the following
specifications apply.
1 Title: All procedures must have a title. This title may be provided by a section

heading. If not, a dedicated title must be provided. The title must be descriptive.
Use: How to power up the system
Do not use: Procedure
In Microsoft Word, use style GenericTitle.
In XML DocBook, use element <title> within <procedure>.

2 Prerequisites: A procedure may have any number of prerequisites. These must
be listed before the first step.
In Microsoft Word, use style Normal with or without a list.
In XML DocBook, use element <para> with or without or a list after <title>
within <procedure>.

3 Admonitions: A procedure may require admonitions. These must be listed before
the first step. Use the standard styles for admonitions.
In XML DocBook, use applicable element after <title> and <para> within
<procedure>.

4 Steps:
• Each step in the procedure must be written as a numbered instruction.

In Microsoft Word, use style List:Number.
In XML DocBook, use element <step> within <procedure>.

• Standard roman numbers shall be used.
• Each step shall only provide one instruction.
• Do not describe results from the action, or any other comments related to the

instruction, in the same numbered paragraph. Always use separate paragraphs
intended to the same level as the instruction text.
In Microsoft Word, use style List:Comment.
In XML DocBook, use a second element <para> within the <step>.

• Important comments or results may be rephrased to form a new instruction.
• If more than three results or comments are required following a step, use a

bullet list.
In Microsoft Word, use style List:Comment.
In XML DocBook, use a second element <itemizedlist> after the <para>
within the <step>.

5 Sub-procedures:
• Sub-procedures may be used to organize a set of separate instruction under one

step in the procedure.
• The sub-procedure must be written as a separate list below the instruction using

alphanumerical identification.
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In Microsoft Word, use style List:Subletter.
In XML DocBook, use a second element <orderedlist
numeration=”loweralpha”> after the <para> within the <step>.

6 References: Links and/or references to other sections, chapters or documents must
not be placed within the numbered step. Always use separate paragraphs intended to
the same level as the instruction text.
In Microsoft Word, use style List:Comment.
In XML DocBook, use a second element <para> within the <step>.

7 Illustrations: It is permitted to use illustrations within the procedure.
8 Tables: It is permitted to use tables within the procedure.
9 Check off methods: It is permitted to use applicable check off methods to make sure

that the procedure is done step by step, or to allow for results and/or signatures
after each step.
• A check off rectangle may be positioned before the instruction text. The same

type of rectangle must be used in all relevant procedures in the manual.
• A check off table may be placed after the instruction to allow for signatures,

results etc.

Example
How to write a procedure

Observe the following prerequisites:
• You need the correct tools
• You need ample lightning.
1 Carry out the first instruction.
2 Push the On button to start the machine.

The red lamp is lit.
For more information, see the Reference manual.

3 Perform the start sequence.
a Press the Alpha button.
b Press the Bravo button.
c Observe that the fan starts.

4 Carry out the next instruction.
5 Instruction with a check off rectangle before the text.
6 Instruction with a check off table to allow for results and/or signatures.

Result Signature
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Tables

This chapter specifies the general rules related to the use of tables.

Topics
• The purpose of tables on page 46
• Tables for tabular information on page 46
• Tables used as a layout method on page 48

The purpose of tables
A table is both a mode of visual communication and a means of arranging data. The
use of tables is pervasive throughout all communication, research and data analysis.
Tables appear in print media, handwritten notes, computer software, architectural
ornamentation, traffic signs and many other places. The precise conventions and
terminology for describing tables varies depending on the context. Moreover, tables
differ significantly in variety, structure, flexibility, notation, representation and use. In
books and technical articles, tables are typically presented apart from the main text in
numbered and captioned floating blocks.
In our documents, the use of tables serve the following purposes:
1 Used as method to organize information, tables allow you to place tabular

information in a tidy manner.
2 Used as a layout method, tables allow you to place text and illustrations next to

each other.

Tables for tabular information
A table set up to contain tabular information shall have a uniform appearance. The
following specifications apply for all tables.

Specifications for tables used to hold tabular information
1 Table location: From left text margin
2 Table width: Adjusted for best fit
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Note

Tables must never exceed the text margins!

3 Column widths: Adjusted for best fit
4 Cell font: Several cell fonts are permitted:

• Default: 12 pt. Times New Roman Regular
• Alternative: 10 pt. Times New Roman Regular
Always use the default font or the alternative size. Only one font and size must
be used in a given table.
In DocBook XML, use <table role=”smalltext”> to use alternative text size.

5 Cell font, header row: Same as other cells, but in Bold typeface
6 Shading, header row: 10% black (Arbortext XML: “Gray1”)
7 Cell margins: 5 pt. (over, under and on each side of the text in the cell)
8 Border width: 1 pt. single line, black
9 Text justification: Left, except when particular circumstances permit otherwise
10 Caption: See the layout specification for TableCap:Left on page 61 and for

TableCap:Wide on page 62.
The use of a caption is not mandatory on small tables. However, when a table,
due to its length and/or positioning, is split over two or more pages in a book, a
caption must be used.
In DocBook XML, only TableCap:Left is implemented. Use element <title>
within <table>. For tables without caption, use element <informaltable>.

11 Table split over several pages: When a table, due to its length and/or positioning,
is split over two or more pages in a book, the caption and the header row must be
repeated at the top of each page.

Table 1 Example using default font size

Header Row, Cell 1 Header Row, Cell 2 Header Row, Cell 3
Row 1, Cell 1 Row 1, Cell 2 Row 1, Cell 3
Row 2, Cell 1 Row 2, Cell 2 Row 2, Cell 3

Table 2 Example using smaller font size

Header Row, Cell 1 Header Row, Cell 2 Header Row, Cell 3

Row 1, Cell 1 Row 1, Cell 2 Row 1, Cell 3

Row 2, Cell 1 Row 2, Cell 2 Row 2, Cell 3
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Tables used as a layout method
In several text editors, tables provide an efficient method to place text and illustrations
next to each other.

Specifications for tables used as a layout method

1 Table location: From left text margin
2 Table width: Adjusted for best fit

Note

Tables must never exceed the text margins!

3 Column widths: Adjusted for best fit
4 Cell font: Standard Normal style, see Normal on page 52
5 Cell font, header row: No header row is used
6 Shading, header row: No shading is used
7 Cell margins: 0 pt. (over, under and on each side of the text in the cell)
8 Border width: No border (invisible)
9 Text justification: Left
10 Caption: No caption is used
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Styles

This chapter specifies the standard style provided with the End user documentation.

Topics

• Using standard styles on page 49
• Default style properties on page 51
• Text styles on page 52
• List styles on page 56
• Caption styles on page 60
• Styles for the Title page on page 62
• Heading styles on page 64
• Admonition styles on page 69
• Styles for the Table of contents on page 72
• Special styles on page 74
• Character styles on page 75

Using standard styles
Standard styles must be used whenever possible. The use of standard styles will allow
you to write documents faster and easier, and the resulting document will have a more
professional look.

Using a standard template and a standard set of styles will also allow you to share
documents with other organisations within KONGSBERG without the need to set up
the document layout every time. Also, the various text editors will have a much better
chance of converting documents with minimum editing required if similar components in
the various systems have identical names. The fewer component definitions/names one
must remember, the simpler life will be when converting from one system to another.
Do not generate new styles unless absolutely necessary, and if you do so, keep them
local in your current document.
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Which styles to use
If you work with XML files, you do not need to relate to the styles at all, they are
automatically added to the document when you create your output file (PDF, CHM or
HTML). If you work with Microsoft Word, you must relate to the list of predefined
styles in the template, and you must manually place and adjust the size and layout of
illustrations.

Styles for Microsoft Word

With Microsoft Word, the most common styles are:
• For normal text, use default style Normal.
• If you need to indent your text to fulfil special context requirements, use styles

Indent:1 and Indent:2.
• To create bullet lists, use styles Bullet:1 and Bullet:2.

Note that Bullet:2 is intended for use only within a Bullet:1 list (nested).
• To create numbered lists, use style List:Number.

The style List:SubLetter is designed to be used within a numbered list to create
“sublists”.

• Procedures are created using styles List:Number and List:Comment. What to do is
always written in a numbered paragraph using imperative mood, while comments to
the described action is provided in the List:Comment paragraph.

• To create headings, use styles Head:X if you wish to omit numbers, or styles Heading
X if you wish to use numbered headings.

• For notes, cautions and warning, use styles Remark:Note, Remark:Caution and
Remark:Warning as appropriate.

• For captions, use styles FigCap:Left or FigCap:Wide depending on the physical
appearance of the illustration.

• Use style TableCap:Wide for table caption.

Styles for Arbortext XML Editor using DocBook DTD

Arbortext XML Editor does not use styles.

All information is placed in “tags” in an ASCII file, and a stylesheet adds the layout to
the text during the publishing process. Which tags to use is defined by the document type
definition (DTD), which also controls the structure of the document.

The most common DTDs are DocBook and DITA.

The following tags are the most frequently used with the DocBook DTD:
• For normal text, use tag <para>.
• To create bullet lists, use tag <itemizedlist>. Bullet lists can be nested to create

“sublists”.
• To create numbered lists, use tag <orderedlist>. Numbered lists can be nested to

create “sublists”. A numbered list can also contain a bullet list.
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• Procedures are created using tag <procedure>. Procedure lists can contain numbered
and/or bullet lists to create “sublists”.

• Headings are created using the <title> tags at the top of sections and chapters. The
heading levels are generated automatically based on the structure.

• For notes, cautions and warning, use tags <note>, <remark> and <warning>. Note
that any of these may contain more than one <para>, and even other elements.

• For figure captions, use the <title> tag in the <figure>.
• For table captions, use the <title> tag in the <table>.

Space above and below paragraphs and headings
The “Space above/below” distances apply to the particular style. The total distance
separating any two consecutive styles will be the space below the first style added to the
space above the second. The settings required to achieve the defined distances will differ
depending on the editor in use.

Unless otherwise noted, the “space below” is always set to 0. Certain writing systems
employ a distribution function such that the space between lines of text and between
the various components on a page is automatically compressed or expanded to fit the
text/components on the page. If such a system function is used, the “Space above/below”
measurements defined here may be adjusted slightly by the system.

Default style properties
Observe these default style properties.

Default properties for text styles
The following properties are default for all text styles, except when otherwise specified
• Font: Times New Roman
• Size: 12 pt.
• Font style: Regular
• Line spacing: 16 pt.
• Colour: Black
• Breaks: Allowed before, after and within
• Page break before: No
• Tabs: None
• First line indent: 0 mm
• Space below: 0 pt.
• Alignment: Left
• Style for next paragraph: Normal
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Default properties for header styles
The following properties are default for all header styles, except when otherwise specified

Note

Sections may be numbered or numbered. Use of section numbering is determined by the
current KM DocForum policy.

Section numbering will be used if specified in a delivery contract, or in a layout or
document standard specified in a delivery contract.

All heading titles shall be written using “sentence case” with only the first character in
upper case. Remaining characters are all lower case, except for names.

• Font: Verdana
• Font style: Bold, Sentence case
• Line spacing: 16 pt.
• Colour: Black
• Location: From left page margin
• Breaks: Allowed before, but not after and not within
• Page break before: No
• Tabs: None
• First line indent: 0 mm
• Space below: 0 pt.
• Alignment: Left
• Style for next paragraph: Normal

Text styles
The standard style for normal text (body text) is Normal.

Normal
Use this style for all body text.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Layout: Text from left margin
• Location: From left page margin
• Line spacing: At least 14 pt.
• Space above: 6 pt.

52 164830/C



Styles

XML DocBook

Use tag <para>. The stylesheet must reflect the specifications for Microsoft Word.

Special XML Docbook element

In XML DocBook, the element <formalpara> may be used to place a single paragraph
with a generic title. The title parameters are those defined for GenericTitle on page 69.

NormalSmall
This style is only intended for these special purposes:
• Table cells
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 9 pt. Times New Roman normal
• Location: From left text margin
• Line spacing: At least 11.5 pt.
• Space above: 6 pt.

XML DocBook

Use tag <para> with attribute <role = “smalltext”>.

Tip
A Tip is used to draw the reader’s attention to a useful hint, for example a suggestion.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font:

– “Tip”: 11 pt. Verdana Regular
– Text: 12 pt. Times New Roman, Regular

• Layout: The word "Tip" is placed on the left page margin. The text follows after a
single space character. Full width border lines are automatically inserted before and
after the Tip.

• Location: From left page margin
• Space above text: 9 pt.
• Space below text: 6 pt.
• Space between upper border line and text: 6 pt.
• Space between upper border line and text: 6 pt.
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• Line spacing: Same as style Normal, see Normal on page 52.
• Breaks: Allowed only above and below, not within the note.

XML DocBook

Use element <tip>, which may contain one or more <para> elements. Note that a
variation to this layout is permitted in XML DocBook. This variation allows the word
“Tip” to be inserted at the left side of the top border line.

Tip

This is an example. It shows how a Tip is presented in XML DocBook. The Tip contains
information that might be useful.

Important
An Important element is used to draw the reader’s attention to something important, but
still not worth an note, caution or warning.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word

• Font:
– “Important”: 11 pt. Verdana Regular
– Text: 12 pt. Times New Roman, Regular

• Layout: The word "Important" is placed on the left page margin. The text follows
after a single space character. Full width border lines are automatically inserted
before and after the Important.

• Location: From left page margin
• Space above text: 9 pt.
• Space below text: 6 pt.
• Space between upper border line and text: 6 pt.
• Space between upper border line and text: 6 pt.
• Line spacing: Same as style Normal, see Normal on page 52.
• Breaks: Allowed only above and below, not within the element.

XML DocBook

Use element <important>, which may contain one or more <para> elements. Note
that a variation to this layout is permitted in XML DocBook. This variation allows the
word “Important” to be inserted at the left side of the top border line.
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Important

This is an example. It shows how a <important> element is presented in XML
DocBook. The <important> elements contains information that is important for the
reader.

Disclaimer
Use this style for all body text in the disclaimers.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word

• Font size: 10 pt.
• Line spacing: Single line
• Space above: 6 pt.

XML DocBook

Use tag <para> within <legalnotice>. The stylesheet must reflect the specifications
for Microsoft Word.

Quote
Use this style for all quotes in the document. In all scientific writing, quotes are important
to communicate direct transcripts from other written work. Scientific writing supports
a number of rules to when and how quotes can be used. Most important, transcripts
must always be true to the source. Also, they must include (at least) the authors name,
and which year the text was originally published. Whenever a quote is used, it is also
expected to include a full reference to the quoted work. This is done either in a footnote,
and/or in a list of references at the end of the book.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word

• Font size: 11 pt.
• Line spacing: Single line
• Space above: 6 pt.
• Left margin: 10 mm
• Right margin: 10 mm.
• Source reference (author): New line, right aligned, line starts with a hyphen.
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XML DocBook

Use tag <blockquote> with a nested <attribution>. The stylesheet must reflect the
specifications for Microsoft Word.

Example

The rule once was that the type for chapter headings should be larger than the text
type, but not so large that it should dwarf the text. Although this design fashion is
now out-of-date, certain typographic conventions still apply. [...] Chapter headings
are often set in all caps or in caps and small caps. [...] In titles and major headings
of all kinds (including newspaper headlines) hyphenation should be avoided.

— James Felici, 2003

List styles
Two types of itemized (bullet) lists are defined, as well as two types of numbered lists.

Bullet:1
Use this style to create a level 1 bullet list. This type of layout is used for standard lists
and other places where the information needs to be accentuated.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Layout: Bullet character, hanging indent to 5 mm, text
• Location: From left text margin
• Space above: 6 pt.
• Tabs: 0 and 5 mm
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

For nested lists, see Bullet:2 on page 56.

XML DocBook

Use tag <itemizedlist>. The stylesheet must reflect the specifications for Microsoft
Word. Nested lists are styled automatically.

Bullet:2
Use this style to create a level 2 bullet list.

Observe the Default style properties on page 51 as well as the following specific
parameters.
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Microsoft Word
• Layout:: Indent to 5 mm, dash, hanging indent to 10 mm, text
• Location: From left text margin
• Space above: 6 pt
• Tabs: 0 and 10 mm
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Use tag <itemizedlist> in a nested structure. This will automatically increase the
bullet level.

Bullet:3
Use this style to create a level 2 bullet list.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Layout:: Indent to 10 mm, asterix, hanging indent to 15 mm, text
• Location: From left text margin
• Space above: 6 pt
• Tabs: 0 and 10 mm
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Use tag <itemizedlist> in a nested structure. This will automatically increase the
bullet level.

List:Number
This style is used to make numbered lists for procedures etc.
Every time a new numbered list is inserted into the document, the numbering must
automatically restart from 1.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Numbering: Sequential numbering in bold typeface, generated automatically.

When a new list is created, the number shall automatically restart at 1.
• Layout: Number, hanging indent to 8 mm, text

164830/C 57



Kongsberg End user documentation

• Location: From left text margin
• Space above: 6 pt.
• Tabs: 0 and 8 mm
• Style for next paragraph: List:Number
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Use the <orderedlist> element to create a numbered list, or the <procedure>
element to create a procedure. These shall have the same appearance. The <procedure>
element allows you to define a title for the procedure. Note that the <procedure>
element is not allowed inside a table (DTD limitation).

Nested procedures

A procedure within a procedure is known as a nested procedure. Nested procedures shall
use numeration a, b, c etc. using lower alpha characters, and each line shall be indented
with 8 mm from the left text margin. In XML Docbook, use <procedure> within a
procedure <step>, or <substeps> within a procedure <step>.

Note

You are only permitted to nest procedures in one level. Too many levels will confuse
the reader.

Continued numbering in XMl DocBook

Normally, the numbering restarts at the beginning of each new ordered list. If you want a
new ordered list to continue numbering where the previous ordered list left off, press
Ctrl-D and use <orderedlist continuation=”continues”>.

List:SubLetter
This style is used below a List:Number paragraph when the major list must be subdivided
and the sub-list must also be "numbered".

Every time a new sub-lettered list is inserted into the document or into a numbered list,
the alphanumerical sequence must automatically restart from “a”.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Numbering: Sequential lower case letters in bold, automatic

Every time a new sub-lettered list is inserted into the document or into a numbered
list, the alphanumerical sequence must automatically restart from “a”.
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• Layout: Indent to 8 mm, lower case alphanumerical character, hanging indent to
16 mm

• Location: From left text margin
• Space above: 6 pt.
• Tabs: 0 and 10 mm
• Style for next paragraph: List_SubLetter
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Sub-letter lists are created automatically in XML DocBook when an <orderedlist> is
nested within an <orderedlist> or a <procedure>. The lower case letter may be set
manually using attribute numeration = loweralpha. The stylesheet must reflect the
specifications provided for Microsoft Word.

List:SubRoman
This style is used below a List:SubLetter paragraph when the major list must be
subdivided and the sub-list must also be "numbered".
Every time a new sub-lettered list is inserted into the document or into a numbered list,
the alphanumerical sequence must automatically restart from “a”.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Numbering: Sequential roman numerals, automatic

Every time a new sub-roman list is inserted into a sub-letter list, the roman numerical
sequence must automatically restart from “I”.

• Layout: Indent to 16 mm, lower case alphanumerical character, hanging indent to
24 mm

• Location: From left text margin
• Space above: 6 pt.
• Tabs: 0 and 10 mm
• Style for next paragraph: List_SubLetter
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Sub-letter lists are created automatically in XML DocBook when an <orderedlist> is
nested within an <orderedlist> or a <procedure>. The lower case letter may be set
manually using attribute numeration = loweralpha. The stylesheet must reflect the
specifications provided for Microsoft Word.
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List:Comment
This style is used in numbered list whenever a comment, a brief description or
other minor explanations are required between the specific numbered tasks. When a
List:Comment is inserted into a numbered list, for example a procedure, the numbers
are not reset.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Numbering:: None
• Layout:: Hanging indent at 8 mm, text
• Location: From left text margin
• Space above: 6 pt.
• Tabs: 0 and 20 mm
Note that long lists will take up lots of vertical space. To reduce this space, you may
manually change Space above to 4 pt. for all the items in the list except the first one.

XML DocBook

Use the <para> element in a nested <orderedlist> or <procedure>. This will
automatically create the correct appearance.

Special functionality for XML DocBook

This feature is automatically implemented in XML DocBook using nested lists and
paragraphs within each <listitem> or <step>. The XML stylesheets support this for
both ordered and numbered lists in three levels.

Caption styles
Captions are used to identify tables and illustrations.

The use of captions is optional.

When a table or illustration is placed into the document, the caption can be located as
follows:
• Aligned left above the table or illustration
• At the left or right side of an illustration
• At the left below the table or illustration
• Centred below the table or illustration
The captions can be numbered.

You are permitted to use the automatic caption provided in Microsoft Word, but make
sure that the text is in italics.
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FigCap:Left
This style is used for captions positioned left aligned above or below an illustrations.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font style: Italics
• Layout: “Figure”, hard space, number (automatic), caption text
• Location: From left page margin
• Space before: 8 pt.
• Space after: 5 pt.
• Breaks: Only allowed after
Note that the word “Figure” is written with a upper case F, and that the word must not
be abbreviated.

XML DocBook

Use the <title> element in <figure>. The stylesheet must reflect the specifications
for Microsoft Word. If the caption is omitted, use the <informalfigure> element.

FigCap:Wide
This style is used for captions positioned above, below or on the left side of illustrations.
Except for the justification, the characteristics are identical to those of FigCap:Left style,
see FigCap:Left on page 61.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Observe the specifications for FigCap:Left on page 61.
• Justification: Centre

XML DocBook

Use the <title> element in <figure>. Only the layout specified for FigCap:Left is
used. If the caption is omitted, use the <informalfigure> element.

TableCap:Left
This style is used for table captions positioned left aligned above or below a table.
Observe the Default style properties on page 51 as well as the following specific
parameters.
Except for the layout, the characteristics are identical to those of FigCap:Left style, see
FigCap:Left on page 61.
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Microsoft Word
• Observe the specifications for FigCap:Left on page 61.
• Layout: “Table”, hard space, number (automatic), caption text
Note that the word “Table” is written with a upper case T, and that the word must not
be abbreviated.

XML DocBook

Use the <title> element in <table>. The stylesheet must reflect the specifications for
Microsoft Word. If the caption is omitted, use the <informaltable> element.

TableCap:Wide
This style is used for captions positioned above, below or on the left side of a table.

Except for the justification and layout, the characteristics are identical to those of
FigCap:Left style, see FigCap:Left on page 61.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Observe the specifications for FigCap:Left on page 61.
• Justification: Centre
• Layout: “Table”, hard space, number (automatic), caption text

XML DocBook

Use the <title> element in <table>. Only the layout specified for TableCap:Left is
used. If the caption is omitted, use the <informaltable> element.

Styles for the Title page

FrontTitle
Use this style for the main title on the Title page.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 24 pt. Verdana bold and italic
• Justification: Right
• Location: Right page margin
• Space above: 100 pt.
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Do not use all upper case characters in the FrontTitle.
If you need two lines for the title text, do not add an extra FrontTitle paragraph. Instead,
press Ctrl-Enter to make a new line within the existing paragraph.

XML DocBook

Use tag <title> in <book>.

FrontSubTitle
Use this style for the subtitle on the Title page.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 18 pt. Verdana bold and italic
• Justification: Right
• Location: Right page margin
• Space above: 22 pt.
Do not use all upper case characters in the FrontSubTitle. If you need two lines for the
title text, do not add an extra FrontSubTitle paragraph. Instead, press Ctrl-Enter to make
a new line within the existing paragraph.

XML DocBook

Use the <subtitle> element within <book>.

PartNumber
Use this style to provide the product’s part number (when applicable) on the Title page.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 12 pt. Verdana normal
• Justification: Right
• Location: Right page margin
• Space above: 22 pt.

XML DocBook

Use the <invpartnumber> element within <bookinfo>.

ReleaseInfo
Use this style to provide product release information (when applicable) on the Title page.
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Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 12 pt. Verdana normal
• Justification: Right
• Location: Right page margin
• Space above: 8 pt.

XML DocBook

Use the <releaseinfo> element within <bookinfo>.

Ingress
Use this style for text containing the ingress on the title page.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: Times New Roman
• Size: 13 pt.
• Indentation: 40 mm
• Space before: 22 pt.

XML DocBook

Use one or more <para> elements inside a <abstract> element within <bookinfo>.

Heading styles
Note

All heading titles shall be written using “sentence case” with only the first character in
upper case. Remaining characters are all lower case, except for names.

Head:1 / Heading 1
Head:1 is the top level of headings, often referred to as Level 1. In templates for
Microsoft Word the proprietary style Heading 1 is provided as well.
A chapter heading using Head:1 (or Heading 1) shall always start at the top of a new page.
Observe the Default style properties on page 51 as well as the following specific
parameters.
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Microsoft Word

• Font: 30 pt. Verdana normal
• Alignment: Right
• Layout:

– Head:1: Text
– Heading 1: Number, hard space, text

• Space above: 0 pt.
• Space below: 130 pt.
• Numbering: [2]

– Head:1: None
– Heading 1: Level 1 using a single digit.

• Page break before: Yes

About heading styles in Microsoft Word

Microsoft Word does not permit the style Head:n to contain automatic chapter or section
numbering, as this is only allowed for the default style Heading n. In Microsoft Word,
the Head:n style does not contain any numbering, while style Heading n is used when
numbering is required by a delivery contract, or a layout or documentation standard
specified in a delivery contract.

XML DocBook

Use the <title> tag at the top of each chapter or section tag. The level will
automatically be adjusted depending on the context. To switch numbering on or off, use
the relevant style sheet. You can force sections to start at the top of a new page by
using <section role=”newpage”>.

Special version for XML DocBook documents

In XML documents, a small document – typically less than 10 effective pages – may
be defined as a small document. This is done by setting the following role: <book
role=”shortdoc”>. When this role has been applied, the Head:1 style is changed as
follows:

• Alignment: Left

• Space above: 40 pt.

• Space below: 0 pt.

• Page break before: No

2. Numbering shall only be used if specified in a contract. See Section numbering on page 16.
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Special function for XML DocBook documents

You may force your chapter heading to start at the top of the next odd page by using the
following role: <chapter role=”rb”>.

Head:2 / Heading 2
Head:2 is the second level of headings, normally referred to as Level 2. In templates for
Microsoft Word the proprietary style Heading 2 is provided as well.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 19 pt. Verdana normal
• Layout:

– Head:2: Text
– Heading 2: Number, indent to 15 mm, text

• Space above: 38 pt.
• Numbering: [2]

– Head:2: None
– Heading 2: Level 2 using two digits separated by point. First digit is taken from

previous Heading 1, second to run consecutively till next Heading 1.

About heading styles in Microsoft Word

Microsoft Word does not permit the style Head:n to contain automatic chapter or section
numbering, as this is only allowed for the default style Heading n. In Microsoft Word,
the Head:n style does not contain any numbering, while style Heading n is used when
numbering is required by a delivery contract, or a layout or documentation standard
specified in a delivery contract.

XML DocBook

Use the <title> tag at the top of each chapter or section tag. The level will
automatically be adjusted depending on the context. To switch numbering on or off, use
the relevant style sheet. You can force sections to start at the top of a new page by
using <section role=”newpage”>.

Note

Head:1 style is defined with a fixed space below, and Head:2 is defined with a space
above. In the event that a Head:2 is placed immediately after a Head:1, these spaces will
be added, and the result is an incorrect space value. In XML DocBook, this has been
rectified in the style sheet, but in Word, you must always add an introductory paragraph
after the Head:1 title.
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Head:3 / Heading 3
Head:3 is the third level of headings, normally referred to as Level 3. In templates for
Microsoft Word the proprietary style Heading 3 is provided as well.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 14 pt. Verdana normal
• Layout:

– Head:3: Text
– Heading 3: Number, indent to 20 mm, text

• Space above: 20 pt.
• Numbering: [2]

– Head:3: None
– Heading 3: Level 3 using three digits separated by points. First digit is taken from

previous Heading 1, second from previous Heading 2, third to run consecutively till
next Heading 2 or Heading 1.

About heading styles in Microsoft Word

Microsoft Word does not permit the style Head:n to contain automatic chapter or section
numbering, as this is only allowed for the default style Heading n. In Microsoft Word,
the Head:n style does not contain any numbering, while style Heading n is used when
numbering is required by a delivery contract, or a layout or documentation standard
specified in a delivery contract.

XML DocBook

Use the <title> tag at the top of each chapter or section tag. The level will
automatically be adjusted depending on the context. To switch numbering on or off, use
the relevant style sheet. You can force sections to start at the top of a new page by
using <section role=”newpage”>.

Head:4 / Heading 4
Head:4 is the fourth level of headings, normally referred to as Level 4. In templates for
Microsoft Word the proprietary style Heading 4 is provided as well.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Size: 11 pt. Verdana bold
• Layout:
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– Head:4: Text
– Heading 4: Number, indent to 20 mm, text

• Space above: 15 pt.
• Numbering: [2]

– Head:4: None
– Heading 4: Level 4 using four digits separated by point. First digit taken from

previous Heading 1, second from previous Heading 2, third from previous Heading 3,
and fourth to run consecutively till next Heading 3, Heading 2 or Heading 1.

About heading styles in Microsoft Word

Microsoft Word does not permit the style Head:n to contain automatic chapter or section
numbering, as this is only allowed for the default style Heading n. In Microsoft Word,
the Head:n style does not contain any numbering, while style Heading n is used when
numbering is required by a delivery contract, or a layout or documentation standard
specified in a delivery contract.

XML DocBook

Use the <title> tag at the top of each chapter or section tag. The level will
automatically be adjusted depending on the context. To switch numbering on or off, use
the relevant style sheet. You can force sections to start at the top of a new page by
using <section role=”newpage”>.

Head:Centre
This is a special heading. It is centred between the page margins. It is only intended as
headings in the front matters of a document, and as a heading for the index at the back of
the document. One typical use is for the phrase Table of contents. This style shall
not contain any number.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Size: 18 pt.
• Font style: Bold, capital first letter of first word, remainder lower case
• Justification: Centred
• Location: Centred between the page margins
• Layout: Text
• Space above: 12 pt.
• Space below: 3 pt.
• Numbering: None
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XML DocBook

Applied automatically as <title> the table of contents, and <title> in index.

Head:Lists
This is a special heading. It is left adjusted, and only intended as headings in lists in
the front matters of a document. Such lists include “list of figures”, list of tables” and
“list of equations”.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: Verdana 12 pt bold
• Font style: Bold, capital first letter of first word, remainder lower case
• Justification: Left
• Location: From left page margin
• Layout: Text
• Space above: 15 pt.
• Space below: 0 pt.
• Numbering: None

XML DocBook

Applied automatically as <title> in the lists.

GenericTitle
This is a generic heading used wherever a small heading is required to increase
readability or simply to enhance the structure. The headings applied with this template
will not be listed in the table of contents. This style shall not contain any number.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• This style is identical to Head:5 (without numbering).

XML DocBook

This title layout is used in the <bridgehead> and as <title> in itemized lists, ordered
lists, procedures and formal paragraphs.

Admonition styles
Three admonitions are defined; Remark:Note, Remark:Caution and Remark:Warning.
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Remark:Note
A Note is used to draw the reader’s attention to a comment or some important information.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font::

– “Note”: 11 pt.Verdana Regular
– Text: 12 pt. Times New Roman, Italics

• Layout: The word "Note" is placed on the left page margin followed by an
explanation mark. The text follows after a single space character. Full width border
lines are automatically inserted before and after the Note.

• Location: From left page margin
• Space above text: 9 pt.
• Space below text: 6 pt.
• Space between upper border line and text: 6 pt.
• Space between upper border line and text: 6 pt.
• Line spacing: Same as style Normal, see Normal on page 52.
• Breaks: Allowed only above and below, not within the note.

Example: “Note” in Microsoft Word

XML DocBook

Use element <note>, which may contain one or more <para> elements. Note that a
variation to this layout is permitted in XML DocBook. This variation allows the word
“Note” to be inserted at the left side of the top border line.

Remark:Caution
A Caution is used to warn the reader that a risk of damage to the equipment exists
if care is not exercised.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font:
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– “Caution”: 11 pt. Verdana Italic
– Text: 11 pt. Verdana Italics

• Layout: The word "Caution" is placed on the left page margin followed by an
explanation mark. The text follows after a single space character. Full width border
lines are automatically inserted before and after the Note.

• Location: From left page margin
• Space above text: 9 pt.
• Space below text: 6 pt.
• Space between upper border line and text: 6 pt.
• Space between upper border line and text: 6 pt.
• Line spacing: 16 pt.
• Breaks: Allowed above and below

Example: “Caution” in Microsoft Word

XML DocBook

Use element <caution>, which may contain one or more <para> elements. Note that a
variation to this layout is permitted in XML DocBook. This variation allows the word
“Caution” to be inserted at the left side of the top border line.

Remark:Warning
A Warning should only be used when it is necessary to warn personnel that a risk of
injury or death exists if care is not exercised.
Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font:

– “Warning”: 11 pt. Verdana Bold, Italic, All caps
– Text: 11 pt. Verdana Bold and italics

• Layout: The word "Warning" is placed on the left page margin followed by an
explanation mark. The text follows after a single space character. Full width border
lines are automatically inserted before and after the Note.

• Location: From left page margin
• Space above text: 9 pt.
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• Space below text: 6 pt.
• Space between upper border line and text: 6 pt.
• Space between upper border line and text: 6 pt.
• Line spacing: 16 pt.
• Breaks: Allowed only above and below

Example: “Warning” in Microsoft Word

XML DocBook

Use element <warning>, which may contain one or more <para> elements. Note that a
variation to this layout is permitted in XML DocBook. This variation allows the word
“Warning” to be inserted at the left side of the top border line.

Styles for the Table of contents
The table of contents in the document is created automatically. Only the first three header
levels are shown. The following styles are defined for the list.

Note that the heading “Table of contents” is created using style Head:Centre, see
Head:Centre on page 68.

The table of contents shall have three levels. In XML DocBook, a fourth level may be
introduced by adding attribute <role=”4levels”> to the <toc> element.

TOC1
The TOC1 style defines the presentation of level 1 in the table of contents. In Microsoft
Word, this is a proprietary style.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 12 pt Verdana Bold, All caps
• Layout: Paragraph number (when applicable), tab (when paragraph number is used),

paragraph name, tab with leading dots, page number
• Location: From left page margin
• Numbering: As defined by Heading 1
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• Space above: 6 pt.
• Line spacing: 14 pt.
• Tabs: 150 mm right

XML DocBook

The table of contents is created automatically. The layout corresponds to the layout
specified for Microsoft Word.

TOC2
The TOC2 style defines the presentation of level 2 in the table of contents. In Microsoft
Word, this is a proprietary style.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 12 pt Times New Roman Regular
• Layout: Paragraph number (when applicable), tab (when paragraph number is used),

paragraph name, tab with leading dots, page number
• Location: From left page margin
• Numbering: As defined by Heading 2
• Space above: 6 pt.
• Tabs: 150 mm right

XML DocBook

The table of contents is created automatically. The layout corresponds to the layout
specified for Microsoft Word.

TOC3
The TOC3 style defines the presentation of level 3 in the table of contents. In Microsoft
Word, this is a proprietary style.

Observe the Default style properties on page 51 as well as the following specific
parameters.

Microsoft Word
• Font: 11 pt Times New Roman Regular
• Indent: 1 cm (or 28 pt)
• Layout: Indent, Paragraph number (when applicable), tab (when paragraph number is

used), paragraph name, tab with leading dots, page number
• Numbering: As defined by Heading 3
• Space above: 4 pt
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• Tabs: 150 mm right

XML DocBook

The table of contents is created automatically. The layout corresponds to the layout
specified for Microsoft Word.

Special styles

Comment
This is a general style for adding comments to the text. The information is omitted from
the document printout by hiding the style from view.

Microsoft Word
• Font: 10 pt. Verdana Regular
• Colour: Red
• Breaks: Allowed before and after, but not within
• Layout:: Text from left margin
• Location: From left page margin

XML DocBook

Use tag <_comment>. You can also apply profile Infotype=”Comment” to any
element, provided that the profile has been defined for the current document. As an
additional function, you can use tag <remark>. This will only be visible if attribute
<status=“draft”> in any <book>, <chapter> or <section>.

Example
This is a general style for adding examples to the text. The examples are numbered. In
order to distinguish the contents of the example from the rest of the text, the entire
example (with all text inside), except the tile, is indented 1 cm from left and right margin.

Microsoft Word
• Observe the specifications for FigCap:Left on page 61.
• Layout:

– Title: “Example”, hard space, number (automatic), caption text
– Contents: As defined by the styles used within the example

• Indent: The entire example (with all text inside) is indented 1 cm for both left and
right margins.

XML DocBook

Use tag <example>.
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Character styles
For semantic elements in XML Docbook, the following specifications apply.
• <guilabel>: Standard typeface, size 90%, bold
• <guibutton>: Standard typeface, size 90%, bold
• <guiicon>: Standard typeface, size 90%, bold
• <guimenu>: Standard typeface, size 90%, bold
• <guimenuitem>: Standard typeface, size 90%, bold

When <guimenuitem> is used immediately after a <guimenu>, an arrow will be
placed before the text within the <guimenuitem> element.

• <guisubmenu>: Standard typeface, size 90%, bold
When <guisubmenu> is used immediately after a <guimenu>, an arrow will be
placed before the text within the <guimenuitem> element.

• <keycap>: Arial bold, 9 pt
• <keycombo>: Arial bold, 9 pt

When two <keycap> elements are placed inside a <keycombo>, a + character is
place before the text in the second <keycap>.
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Front page

The Front page is the very first page in any end user manual.

It is always printed in colour. The reverse page is always blank.
• When the manual is bound in a binder, the Front page is inserted into the pocket at

the front of the binder.
• When the manual is bound using glue or spiral binding, the Front page is placed in

front of the Title page.

Topics

• How to create the ’Front’ page on page 76
• Front page specification on page 76

How to create the ’Front’ page
To create a Front page, you have two options:
1 Create the page using Adobe InDesign, and place it manually into the end user

manual PDF.
2 Create the page using the stylesheets for Arbortext XML.

Front page specification
The detailed specification for the front page and the spine page is provided on:

http://www.km.kongsberg.com/branding

See also .Front page specification on page 77.
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Figure 5 Front page specification

Instruction manual

Kongsberg EM 3000

Multibeam echo sounder

M/V Nordkapp

System drawing and installation instructions

Verdana, 22 pt Bold, White
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84 pt

14 pt

14 pt

42 pt

28 pt

28 pt

28 pt
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Area available for illustration

Baseline grid = 14 pt, starts at top margin.
All titles are aligned to baseline grid.
KOG Blue = CMYK 100/72/0/38
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Metadata for MS Word

This chapter specifies the metadata to be recorded when a new document is created. The
same metadata are collected for all Word documents.

Metadata used by Microsoft Word
1 Category (Word: “Title”)
2 Document title (Word: “Subject”)
3 Subtitle
4 Project no
5 Sub-project no
6 Product
7 Location
8 Synopsis (Word: “Comments”)
9 Document registration number
10 Customer’s document registration number
11 Contract number
12 Revision no
13 Document version no
14 For each revision:

• Revision letter
• Revision date
• Revision reason for issue
• Revision made
• Revision checked
• Revision approved
• Description of change

15 Company name (Word: “Company”)
16 Company web site
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Page examples

This chapter provides example pages to visualize the various specifications.

Topics

• Title page on page 80
• Revision and disclaimer page on page 81
• Table of contents on page 82
• Index on page 83
• End page on page 84
• Graphic frame for drawing files on page 85
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Title page

80 164830/C



Page examples

Revision and disclaimer page
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Table of contents
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Index
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End page
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Graphic frame for drawing files
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